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Crazy Retouch: Part 1 

This is the first of a two-part retouching lesson where we will be focusing on more 
advanced retouching techniques. In the example image, we have a couple of trash 
and recycling bins that are obstructing the garage door of a vintage service station. 
We’re going to remove the bins, but there will be a lot of work involved in doing so.

When tackling a problem like this, I will first look for other parts of the image that 
can be used in the retouch job. For example, the frame of the garage door is red 
and green, and the bottom part of the frame is obstructed by the trash bin. For-
tunately, the upper part of the frame is not obstructed so I know that this upper 
part can be used to fill in the obstructed part. Each individual area will need to be 
looked at in this way and we’ll need to evaluate the entire image, looking for pieces 
that can be used in the area we’re retouching. 

This particular retouch job has 
many challenges that call for 
more advanced techniques. 
One of these challenges is 
shadows. The retouch area is 
partially in shadow so we will 
need to make sure that we 
re-create the shadows in the 
appropriate areas. Perspective 
will create another challenge. It 
may look like a particular area 
can be cloned to fill in the re-
touch area, but the difference 
in perspective will cause the 
two areas to be out of align-
ment. 

In this complex retouch job, we are going to remove the 
trash bins from in front of the garage door.
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Set Up Document & Retouching Tools (Timestamp 9:00)

Work on an empty layer When working on a complex retouch job, it’s always a 
good idea to use layers. In the video example, we’re going to place each part of the 
retouch job on its own layer. That will make things easier in the end, should we need 
to blend different areas together. You don’t always need to use multiple layers, but 
it’s good practice to apply the retouch work to an empty layer above the main im-
age layer. This leaves the original image layer untouched. Create a new, empty layer 
by clicking the New icon ( [+] ) at the bottom of the Layers Panel.

Set up retouching tools There are some settings you will need to work with if 
you’re going to use the retouching tools on an empty layer. The three retouching 
tools we’ll be using are the Clone Stamp Tool, the Spot Healing Brush and the Heal-
ing Brush. Activate each of these three tools, one by one, and set up the following 
settings, which can be found in the Options Bar above the main image window. 

• Clone Stamp Tool: Set the Sample menu 
to Current & Below and make sure the 
“Aligned” check box is turned on.

• Healing Brush Tool: Set the Sample menu 
to Current & Below.

• Spot Healing Brush: Turn on the “Sample 
All Layers” check box. 

How to use the retouching tools To use one of the retouching tools, hold down 
the Option key (Alt on Win) and click on the area that you want to copy. This is 
the sample area. Then, release the Option key and paint over the area you want to 
retouch. This will apply the sampled content in the area where you paint. If you are 
using the Clone Stamp Tool, it will apply an exact copy of the sampled content. If 
you are using the Healing Brush or the Spot Healing Brush, it will attempt to match 
the color and tone of the surrounding area. 

With the Clone Stamp Tool is active, 
the Sample menu is being set to  
Current & Below.
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Open Clone Source Panel The Clone Source Panel contains additional settings for 
the retouching tools. It allows us to manipulate the content that we sampled before 
pasting it within the retouch area. If this panel is not already open on your screen, 
you can open it by clicking on the Window menu and choosing “Clone Source.” 

After using a retouching tool to sample an 
area, some text will appear just beneath the 
five icons at the top of the Clone Source 
Panel. This text includes the name of the 
document from which the content was 
sampled from, as well as the name of the 
layer that contains that sampled content.

There are keyboard shortcuts that can be 
used to change the settings in the Clone 
Source Panel. A few key shortcuts are as 
follows:

LEFT: The Clone Stamp Tool is being 
used to sample an area by holding down 
the Option key (Alt on Win) and then 
clicking on the area. ABOVE: The Clone 
Stamp Tool is being used to paint in the 
sampled content in a different area.

The settings 
inside the 
Clone Source 
Panel can be 
used to  
manipulate 
the content 
sampled by 
the retouch-
ing tools.
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Scale sampled content up: Shift+Option+Right Bracket key ( ] ) on Mac, 
Shift+Alt+Right Bracket key ( ] ) on Windows

Scale sampled content down: Shift+Option+Left Bracket key ( [ ) on Mac, 
Shift+Alt+Left Bracket key ( [ ) on Windows

Rotate sampled content clockwise: Shift+Option+Greater Than Key ( >) on Mac, 
Shift+Alt+Greater Than Key ( >) on Win

Rotate sampled content counter-clockwise: Shift+Option+Less Than Key ( <) on 
Mac, Shift+Alt+Less Than Key ( <) on Win

Adjust offset to move sample position: Shift+Option+Arrow Keys on Mac, 
Shift+Alt+Arrow Keys on Win

By default, when you scale the sampled content, the width 
and height will scale together. Any time you use the key-
board shortcuts for scaling, the width and height will also 
scale together. You will occasionally need to scale the width 
and height separately. In order to do this, you will need to 
click the little link icon between the width and height fields 
in the Clone Source Panel. Then you can manually enter in 
different percentage numbers for the width and height. Personally, I leave the link 
icon turned off. I use the keyboard shortcut for scaling the sampled content when 
I want the width and height to scale together, and I use the width and height text 
fields when I want the width and height to scale separately. 

Reset Clone Source You can reset all of the settings in the Clone Source 
Panel by clicking the Reset button, which looks like a little U-turn arrow, 
on the right side of the panel. It’s always a good idea to reset the panel 
when you’re done working with a retouching tool. The panel will remember the last 
settings you used, so the next time you use a retouching tool, the scaled content 
will be manipulated in some way and that’s usually not what you want. By resetting 
the panel settings when you’re done using a tool, you will be starting fresh the next 
time you activate a retouching tool. 

Click the link icon if you 
want to scale the width 
and height separately.
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By default, there is no keyboard shortcut assigned to this reset button. I, person-
ally, need to reset the panel all the time, so I like to define a shortcut for this but-
ton. You can assign a keyboard shortcut to a particular function by clicking on the 
Edit menu and choosing Keyboard Shortcuts. The Keyboard shortcuts dialog will 
appear. At the top of this dialog, change the “Shortcuts for” menu to the Panel 
Menus option. This will cause the dialog to display all of the menu items that can 
be found within the Photoshop panels. Scroll down and expand the Clone Source 
option to reveal all of the settings that can be found within that panel. Click on 
the Reset Transform option and a text field will become highlighted. Here, you 
can type in the keyboard shortcut that you’d like to use for this command. I used 
Shift+Option+Command+/ . Click OK to exit the dialog. 

I often use a trick when using the retouching tools. I will sample from an area and 
then I’ll click once in the retouch area, applying the sampled content so that the 
alignment is correct. I may even use a really large brush in order to better align 
things. Then I will immediately use the Undo command. This might sound counter-
intuitive because it removes the retouching, BUT it remembers the location where 
I clicked and it locks in the relationship between where I sampled from and where I 
am retouching. I just use that initial click to lock in the alignment. Then, I can either 
use a smaller brush or work with the Clone Source settings in order to refine the 
sampled content that I’m applying. Note that the “Aligned” check box needs to be 
turned on in order for the tool to remember the alignment. 

LEFT: At the top of the Keyboard Shortcuts dialog, the “Shortcuts For” menu is being set to 
Panel Menus. RIGHT: A new shortcut is being assigned to the Reset Transform command.
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Retouch Edge of Garage Door Frame (22:00)

We’ll start with the most straight-forward task of retouching the frame of the ga-
rage door where it is obstructed by the trash bins. The top part of the frame is 
clean (unobstructed) so we will take that part and extend it down in order to cover 
up the trash bin. We’ll make sure that we’re working on the empty layer and we’ll 
activate the Clone Stamp Tool. The Clone Stamp Tool creates a blatant copy of the 
sample area and applies it in the area where we paint. We will sample from an edge 
of the garage door frame, somewhere in the upper portion. Remember, hold down 
the Option key (Alt on Win) and click the mouse button to sample an area. 

Then, we will position the cursor over the trash bin and make sure that the brush 
is large so that we can see the preview inside the brush tip. (The brush tip displays 
a preview of what we’re about to paste.) We’ll line up the preview with the edge 
of the garage and click once to apply the cloning. Then we’ll immediately use the 
Undo command (Command+Z, Ctrl+Z on Win). This will undo the retouching but 
it will have established the offset, which is the position of the retouch area in re-
lation to the sample area. Now that we have that alignment, we will paint again to 
retouch the area. We’ll start to paint, extending the garage edge downward in or-
der to cover up the trash bin. We’ll paint over a larger area than is necessary (see 
screen shot) and that’s ok. The main goal is to extend the green and red edge of 
the garage door downward. 

LEFT: The Clone 
Stamp Tool is being 
used to sample from 
an upper part of the 
garage door frame.  
 
DIRECTLY LEFT: The 
Clone Stamp Tool is 
being used to paint 
the sampled content 
over the bottom,  
obstructed part of  
the door.
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Curves Adjustment to match tone That edge looks 
good, but the tan part of the door area looks darker 
in the area where we painted. It doesn’t quite match 
up with its surroundings. We will correct this by using 
an adjustment layer. We’ll click on the Adjustment 
Layer icon at the bottom of the Layers Panel and 
choose Curves from the pop-up menu. The Curves 
adjustment layer will be added and the Properties 
Panel will appear. Here, we’ll make sure that the Tar-
geted Adjustment Tool is active. It looks like a little 
hand icon on the left side of the panel. This tool will 
allow us to click and drag within the image in order 
to place a point on the curve and move it around. 

Note: I like the Targeted Adjustment Tool to be active all the time and there’s a set-
ting you can use to specify this. If you would like this tool to be active all the time, 
click on the little menu in the top right corner of the panel and choose “Auto-Select 
Targeted Adjustment Tool” from the pop-up menu. 

The Curves Adjustment Layer is at the top of the layer stack, which means it’s go-
ing to affect all of the layers beneath it. We only want the adjustment to affect the 
retouching layer. You can tell an adjustment layer to affect only the underlying layer 
by “clipping” it to that layer. Do this by clicking the left-most icon at the bottom of 
the Properties Panel. It looks like a square with a down-pointing arrow next to it. 
When a layer becomes clipped to the underlying layer, a little down-pointing arrow 
will appear to the left of its thumbnail in the Layers Panel. 

The Targeted Adjustment Tool 
can be found on the left side of 
the Properties Panel.

Click the circled icon to clip an 
adjustment layer to the layer 
beneath it. You can tell that 
a layer is clipped because a 
down-pointing arrow will  
appear to the left of its  
thumbnail in the Layers Panel.
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Now the Curves adjustment will only af-
fect the retouching layer. We’ll use the 
Targeted Adjustment Tool to click once 
within the tan part of the garage door 
(the part that’s too dark). This will place 
a point on the curve that represents that 
tone. We need to move that curve point 
up in order to lighten the targeted area. 
To move a curve point, you can either 
click and drag on it or you can use the 
arrow keys to nudge the point. In this 
example, we need a lot of precision, so 
we’ll use the up arrow key to nudge the 
curve point up. As we do this, we’ll watch 
the retouch area and stop when the tan 
area matches its surroundings. 

The Targeted Adjustment Tool is being used 
to click on the area that is slightly too dark. 
A point is placed on the curve that  
represents the tone we clicked on.

After placing a 
point on the curve, 
we are using the 
up arrow key to 
nudge the point 
upward, lightening 
the area we  
targeted. 
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Looking at the results, the green part of the layer no longer matches the surround-
ing green edge. We had lightened the entire retouch area in order to match the 
tan part of the garage, but as a result, the green area became too bright. That’s 
ok though. We are using an adjustment layer that has a mask attached to it. By 
painting on the mask with black, we can hide the adjustment in specific areas. We’ll 
make sure the layer mask is active and we’ll use the Brush Tool to paint with black 
over the green edge part of the retouch layer. This hides the adjustment in the area 
where we paint, removing the lightening effect from the green edge.

Hide the excess parts of the retouching layer When we used the Clone Stamp Tool 
to retouch the edge of the garage door, we painted in more areas than we needed 
to. Now, we’ll remove those parts of the retouch layer that we don’t need. That can 
be done by either using the Eraser Tool or by using a layer mask. The layer mask 
method is more forgiving because we can bring content back if we make a mistake. 
We’ll make sure the retouch layer is active and we’ll click on the Layer Mask icon at 
the bottom of the Layers Panel. The layer mask thumbnail will appear next to the 
layer thumbnail and it will be white by default. When a layer mask is white, it means 
that the entire layer is visible. We need to add black to the mask in order to hide it 
in specific areas.  

We’ll activate the Brush Tool and make 
sure that the foreground color is set 
to black. We’ll use a relatively hard-
edged brush. The setting for this can 
be found in the Options Bar above the 
main image window. In the lesson vid-
eo, we set the hardness to about 75%. 
Now, we’ll use the Brush Tool to paint 
on the mask with black in the areas 
where there is excess. We don’t want 
this retouching layer to cover the front 
face of the garage door, so we’ll paint 
over that area. Adding black to the 
mask hides parts of the retouch layer. 

A layer mask was added to the retouch layer and 
we’re painting with black in order to hide parts 
of the layer, removing the excess retouching.
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Tip: When using the Brush Tool, there is a trick for creating a perfectly straight line. 
Click once on the image. Hold down the Shift key and click somewhere else. The 
Brush Tool will create a perfectly straight line between the two points in which you 
clicked. That’s what we did in the video example to create a straight line along the 
front face of the garage door.  

Retouch Wall left of Garage (32:40)

The next area we’re going to retouch is the stucco wall that appears on the left side 
of the garage door. The bottom portion is obstructed by the trash cans. The stucco 
wall on the right side of the garage door is not obstructed and it is also in the sun, 
so we can use this area to sample from and then paste to the obstructed side. 

We will apply this part of the retouching on its own layer, so we’ll click the New 
Layer icon ( [+] ) at the bottom of the Layers Panel. We ultimately want this wall 
portion that we’re going to recreate to be tucked under the green garage door 
frame, so we will drag this new layer down in the layer stack, so that it is positioned 
just above the background layer. 

We’re going to 
sample from the 
wall on the right 
side of the garage 
and then paste it 
on the left side, 
hiding parts of 
the trash bins.
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We’ll activate the Clone Stamp Tool and open the Clone Source Panel. We’ll make 
sure that the options within the Clone Source Panel are at their default settings. 
Then we’ll use the Clone Stamp Tool to sample an area from the stucco on the right 
side of the door. In the video example, we sampled right on the corner of the wall. 
We’ll align the sampled area with the retouch area and then click and drag down to 
paint in the sampled content over the wall to the left of the garage door. We’ll paint 
in more than we need, knowing we can remove the excess later. 

LEFT: The Clone Stamp Tool is being 
used to sample part of the wall to the 
right of the garage. 

BELOW: The Clone Stamp Tool is  
being used to paint the sampled area  
to recreate the wall on the left side of 
the garage.
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Using guides when painting We now need to remove the excess retouching and 
we’ll again use a layer mask to do that. We’ll add a layer mask to this retouching 
layer by clicking the Layer Mask icon at the bottom of the Layers Panel. Then, we’ll 
use the Brush Tool and paint with black (on the mask) in the areas where there is 
overspill in the retouching area. 

In this example, we have a challenge because we can not see where the edge of 
the stucco wall should be. The retouching layer is covering it up. The edge of the 
wall is perfectly vertical though, so we can use a Photoshop guide to help us see 
where we should paint. 

In order to use Photoshop guides, 
the rulers must be visible in the in-
terface. Toggle the visibility of the 
rulers by using the keyboard short-
cut Command+R (Ctrl+R on Win) 
or by clicking on the View menu 
and choosing Rulers. We want to 
create a vertical guide and we can 
do that by clicking within the ver-
tical ruler on the left side of the 
image window and dragging the 
guide into the document. When 
we release the mouse button, the 
guide will be placed. We’ll position 
the guide to align with the left side 
of the building. This will help us to 
see where we should paint on the 
mask.

The rulers are visible (arrows) and we are dragging 
out a guide (from the left ruler) into the document.
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With the guide now visible, we can con-
tinue to paint, hiding the excess retouch-
ing on the outside of the building (to the 
left of the guide). If we no longer want 
the guides to be visible, we can click on 
the View menu and choose Clear Guides.

Retouch Base of Building (37:36)

If you look on the right side of the garage door, you can see that there is a green 
base that wraps around the building. This base should appear on the left side as 
well. Since both areas are in the sun and equally lit, we can sample the right base 
and apply it to the left side. This brings up some challenges. We need to know how 
that base should be scaled, as the left side of the garage is farther from the camera 
than the right. We also need to know where the base should be positioned (verti-
cally) to make sure it is aligned with the perspective in the image. 

We are using 
the vertical 
guide to paint 
on the mask, 
hiding parts of 
the retouching 
layer.

We’re going to 
sample from the 
base on the right 
side of the garage 
and then paste it 
on the left side.
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We’ll turn off the visibility of all retouching layers, so that we can get a temporary 
view of what’s going on in the base layer. When we do this, we can see a hint of red 
paint between the two bins. This is the red horizontal line that runs above the build-
ing base and we can use this as a guide to determine how high up the base should 
be. We’ll turn the visibility back on for the retouch layer that recreated the edge 
of the garage door. This will also help us to determine the positioning of the base. 

We’ll create a new, empty layer on which to place the retouching for the building 
base. This needs to be above the other retouching layers so we’ll move this new 
layer to the top of the layer stack. We’ll activate the Clone Stamp Tool and sample 
from the corner of the right building base. Then, we’ll make the brush large enough 
that we can better see the preview of what we sampled inside the brush tip. We 
want to make sure we align those red lines above the building base. Then we’ll click 
and drag to paint in the base, again painting in a little more than we need. 

We can see a bit 
of the red line 
that runs along 
the top of the 
building base. 
This will help us 
to determine how 
high the base 
should be  
inserted.

FAR LEFT: The Clone 
Stamp Tool is being 
used to sample from 
the base on the right 
side of the garage.  
DIRECTLY LEFT: We 
are painting in the 
sampled content on 
the left side.
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The result doesn’t look quite right, 
and that’s because of perspective. 
We directly copied the base from 
the right side and applied it to the 
left side. The problem is that the 
left side is farther from the camera 
and therefore the base should be 
smaller. If we turn on the visibili-
ty of the stucco retouch layer, we 
can see how wide the base should 
truly be. 

Free Transform to scale a layer We can scale the base down by using the Free 
Transform command. We’ll click on the Edit menu and choose Free Transform. 
Transform handles will appear around the layer. When scaling this way, you can 
set a reference point which will stay in place as you scale the layer. The point you 
determine will stay in place and the layer will scale around it. This can help us in 
making sure the corner of the base stays aligned with the corner of the building. 

The reference point may not be 
visible by default. (It depends on 
your version of Photoshop and 
your preferences.) If there is no 
crosshair point in the middle of 
the transform handles, you can 
make it visible by turning on the 
Reference Point check box in 
the Options Bar. Click and drag 
on the point to position it on 
the part of the layer you want 
to stay in place. In the video, we 
placed the point on the corner 
of the building base. 

After retouching the base, you can see that it’s  
larger/wider than it should be.

Turn on the Reference Point check box in order to see 
the point when using the Free Transform command.
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To scale the layer around 
this reference point, hold 
down the Option key (Alt 
on Win) and drag the corner 
handles. We’ll scale the layer 
until the edges of the build-
ing align. We’ll hit the Re-
turn/Enter key to lock in the 
transformation and remove 
the transform handles. 

Note: When using the Free 
Transform command, you 
may notice that the width 
and height are not scaling 
proportionally. If that’s the 
case, hold down the Shift key as you scale. This setting is determined by your ver-
sion of Photoshop and your preferences. 

Again, we’ll remove the excess content from this retouching layer by creating a 
layer mask. We’ll activate the Brush Tool and then paint on the mask with black in 
order to remove any overspill. It can be useful to use other parts of the image for 
reference. There are other garage doors that we can refer to in order to determine 
what the bottom of this door should look like. 

We are scaling down the retouch layer and holding down 
the Option key (Alt on Win) so that it scales around the 
Reference Point.

We added a layer mask 
to the retouch layer 
and we’re painting on 
the mask with black in 
order to hide parts of 
the layer that we don’t 
need.
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Clean up the Area Where Building Meets Concrete (50:52)

Now we need to clean up the area where the building meets the concrete. We can 
steal content from another part of the image in order to fill this area in. The area 
where the building hits the ground is in a shadow area. There is another garage 
door in the image, where the bottom is in the shade, so we can use this area to 
sample from. 

We’ll create a new, empty layer on which to place this part of the retouch job. We’ll 
use the Clone Stamp Tool to sample from the bottom corner of the clean (unob-
structed) garage door. 

Then we’ll make the brush very large so that we 
can easily see the preview inside the brush tip. 
This will better help us to align the sampled con-
tent with the retouch area. We’ll click once to 
apply the retouching and then immediately use 
the Undo command (Command+Z, Ctrl+Z on 
Win). This will remove that bit of retouching but 
it will lock in the offset, which is the position of 
the retouch area in relation to the sample area. 
The garage door that we sampled from is closer 
to the camera than the door we’re retouching, so 
we’re going to need to scale down the sampled 
content. 

We’re using the 
Clone Stamp Tool 
to sample from a 
different,  
unobstructed  
garage door.

The Clone Stamp Tool is being used 
to align the sampled garage door 
with the door we’re retouching.
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Remember, the settings in the Clone Source Panel can be used to do this. We can 
use the keyboard shortcut, Shift+Option+left bracket ( [ ) to scale the content 
down. 

When the size matches up, we’ll use the Clone Stamp Tool to paint over the bottom 
corner and bottom edge of the garage door. Again, we’ll paint more than we need 
and then we’ll use a layer mask to remove any excess that we know we can’t use. 

Clean Up Pavement (57:57)

The pavement in front of the garage door still has some shadows from the trash 
bins as well as some other messy areas. We’ll clean that area up next. There is an 
area of clean pavement to the right of the garage, so we’ll use that as the sample 
area.

We’ll create a new, empty layer at the top of the layer stack on which to place this 
retouch job. We’ll use the Clone Stamp Tool to sample from that area of clean con-
crete and then paint over the area in front of the garage door. 

The Clone Stamp 
Tool is being used 
to paint in the  
content that was 
sampled from the 
other garage door.
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Because the sample area was a little darker than the concrete in front of the garage 
door, we’ll need to blend the retouch layer into the underlying image layer. Any-
time we need to blend the retouch area with the surrounding area, we can use the 
Healing Brush. With the Healing Brush active, we’ll look for an area of concrete that 
has the right texture and is relatively consistent in brightness. We’ll sample from 
this area and then we’ll paint over the transition between the retouch area and the 
surroundings. This will cause the areas to blend together. 

The Clone Stamp Tool was used to sample from an area of clean concrete and then paint over 
the messy area in front of the garage door. You can see that the tone doesn’t quite match.

The Healing Brush is being used 
to blend the retouch area with 
the surrounding area.


